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Introduction

What Everyone Needs to Know 

In security, users are the weakest link… Chris Vargas, president of F-Secure 
. 

People who manage their own computer desktops need to learn essential skills to protect the important files on their computer and to increase awareness of the vulnerabilities they face in a networked environment. 

This class will cover the basics you need to know including: 

· Physical Security – How do I keep my hardware and key files safe/

· Password Security – What is a good password and how do you set one?

· Computer Viruses – What they are and how to protect your computer

· Networking on the Desktop – How to protect yourself.

· Firewalls - What the can and can’t do and why they are important for always-on connections. 

· Backup Strategies - Why and how to backup your work

Note: Any changes that you make to the configuration of a machine that interacts with UM systems should be discussed with your system administrator.

Goals of This Workshop

By the end of this workshop you will have hands-on experience with:

· Virus detection software and how to use it

· Hardening a Windows-based computer against basic Internet attacks

· Backing up and restoring critical data using Microsoft’s backup

Assumptions and Prerequisites

This course is designed for all Windows users from novices through all pertinent levels of experience:

· No virus knowledge is assumed.

· No security knowledge is assumed.

· No networking knowledge is assumed.

· No backup experience is assumed.

· Must be familiar with basic Windows operating system functions, using a Mouse, keyboarding

· Should have installation CD for your operating system.

Workshop Format

This workshop is not designed to cover all the features of computer security.  It is designed to use lecture, demonstration, and hands-on exercises to help you to address key security concerns in a network environment at a basic level of competence.  We will go through each feature step-by-step, stopping to reinforce important points.  You will be provided time to ask questions and experiment with the system.

Handout Format

This handout reflects the order in which the material is covered.  It is designed to be a classroom aid, as well as a reference to be used at your personal computer.  The instructor will cover everything in the handout, but there may be some information that is mentioned in the class that is not written in the handout.  The instructor will always endeavor to tell you when the information given verbally is not in the handout.

Physical Security

Laptop Security

Physical laptop protection primarily consists of attaching a locking security cable to the Universal Security Slot (USS) on your laptop. Security cables can use either keyed or combination locks to secure them to your laptop. The security cable needs to be wrapped around an immovable object and connected to the. For those laptops that do not have a USS, there are adhesive connectors that mount directly to your laptop casing that provide a way to attach the security cable. If there isn't a large immovable object accessible to wrap the security cable around, anchoring devices are available to attach the cable to cubical walls and other stationary objects. If all else fails attach it to a chair. It is much more conspicuous carrying out a chair than a laptop. There are also systems available that sound an alarm if the laptop is moved. These types of devices are useful for those times when you'll be traveling with your laptop and have to put it down.

The data on your laptop might be more valuable to a thief than the device itself. Therefore, it's always best to use good judgment when storing sensitive information on your machine. You should: 

· Minimize the amount of institutional data stored on your machine 

· Do not use any option that "remembers" your password. Reenter your passwords every time you connect 

· Use data encryption tools to protect data stored on your laptop. 

Desktop Security


Desktops are clearly more difficult to steal inconspicuously than laptops, however, components are at a higher risk in a desktop environment. Components such as system memory, microprocessors, and hard disk drives are especially vulnerable. How can you protect your desktop systems and internal system components from theft? 

Besides locking the machine down or sealing it in a cabinet, business desktops often come with a number of features that can help to prevent system and component theft, or mitigate your risk if a theft occurs. 

· Chassis Intrusion Alert:
Intrusion alert software provides notification that the chassis cover has been removed and can be configured to alert the end-user or the system administrator when the system is next rebooted. 

· Configuration Change Alert:
Configuration change alert software provides notification that the system configuration, such as processor, memory, or hard disk drive has been changed. 

· Lock slots:
Desktops usually come with a lock slot. If well designed, this slot will lock both the chassis cover and the system itself.

Other Desktop Theft Prevention Products

If you need a more robust security solution to protect against system or component theft additional security options, include:

· Chassis and Cable Locks

Desktops can be set up with a wide range of standard and custom lock solutions.

· Asset Tags

Asset tags for your systems can be used to help keep track of your company's systems.

PDA Security


As people increasing keep sensitive data on their handhelds and interconnectivity increases, these small devices represent one of the most significant holes in IT security.

The last few months has seen a string of encryption products launched for the ever-growing number of personal desk assistant devices that previously had few security features consisting of little more than password-based authentication.

Increasingly, products are hitting the market that encrypt the records on a handheld’s database. To improve performance, one system decrypts only records that the user requests, and re-encrypts them using idle CPU time once the user is finished. In this system, the user's password ­ that is required for HotSync operations ­ is not stored on the handheld, thereby protecting it from attack.

Several shareware programs
 are available for securing your personal information on your handheld. These applications are designed to add flexibility and resiliency to security on your handheld devices. Often this software focuses on securing personal information.

Using Good Passwords

Every system uses some form of password authentication and therefore must store a representation of the password in order to check whether a logon attempt is valid. Three ways of storing passwords are: 

· Storing the clear text passwords (really weak) 

· Storing an encrypted version of the password (not much better) 

· Storing a unique obscured representation of the password (decent)

It has been common knowledge for quite some time that userid/password authentication schemes are inherently weak. Users usually choose bad passwords (i.e., ones that can easily be guessed), write passwords down, mail passwords to co-workers or share passwords freely by telephone. For this reason, high security environments do not rely on password authentication alone, but combine password security with smart cards or fingerprints
. 

If your hardware manufacture supports it, you may want to set a NetBios password. This password is hardware dependent, less trivial to bypass than other passwords and comes up before an interloper has access to anything. However, use of these passwords makes support more difficult and if you are not administering your own machine, you may want to check on department policy related to such passwords.

Passwords in Windows

Additionally, in Windows 9x and ME, passwords can limit access to your PC through password security. If you have set up password security on your machine (See EXERCISE 1), starting-up your PC causes a window to appear that requests a User Name and Password. Once entered, the computer verifies both by looking for the Username.pwl file (See EXERCISE 2), where the local password is stored.

NOTE: Once you set a screen saver password, you can drag the .SCR file that contains the password to the desktop so that you can activate the screensaver password immediately (with no time delay) when you are planning to be away for your computer for some time.

· Start / Search

· *.scr

· Drag the one you normally use to the desktop

Windows NT/2000 stores users and their associated information in the SAM (Security Accounts Manager) part of the registry. They store both the LanManager (DES) and the Windows/NT (MD4) encrypted hash values. Unfortunately the keys used to encrypt these values are well known. Hence, it is relatively easy to write an NT program that reads the SAM database, decrypts the hash values, and writes them out into a file. 

If the password is entered correctly, the computer logs you on, allowing access to the Windows Desktop. From this point, you can do almost anything on the computer unless the specific applications you access have additional levels of security. 

Although the value of this security is increasing in NT/2000, it is still pretty trivial in most flavors of Windows. You can however increase the level of security on your workstation by using another Microsoft Windows feature. With the addition of Policies, the “owner” or Administrator of a given computer can restrict, based on user IDs, which files and programs each person can view and access. Policies can be a little tricky because they are not enabled by default and require some work to set up and configure. Despite this, they can provide far more advanced security at no additional cost.
What makes a good password?

As you've probably already heard, there are many software programs available now that can guess your users' passwords if they're using words that are in the English or foreign dictionary. 

Instead of mindlessly generating all possible passwords, smart hacking systems use a database of common words and a few rules of thumb to generate all plausible passwords. The databases of these programs commonly include standard dictionaries, names of persons, types of cars and so forth. Common tricks such as reversing the password and substituting 0's (zeroes) for o's (ooo's) are part of the program logic as well. These smart password crackers are remarkably good at guessing peoples passwords
.

Using common sense to set a good password will help create a better security environment. In order to be useful in authentication and authorization, a password should meet the following criteria:

1) Passwords must be at least six characters.

2) Passwords must contain three of the following four types of characters:

i) Uppercase letters

ii) Lowercase letters

iii) Numbers

iv) Non-alphabetic characters such as punctuation marks

3) Passwords shouldn't contain your user name or any part of your full name.

How Do Dictionary Attacks Work?

When a dictionary attack is mounted against a password file, about half
 the guessed passwords come directly from a word list. The rest of the “crackable” passwords are found by applying some simple transformations like those described above to word lists or known user information. Users create passwords in predictable ways. They tend to base their passwords on their username or their full name, using simple prefixes, suffixes or transformations. When guessing passwords, the bad guys perform simple transformations such as:

1. Converting all the letters in a word to lowercase

2. Applying user specific information to a password, such as name, user name, department, spouses’ names, kids’ names, pets’ names or birthdays

3. Using numeric suffixes

a. The number 1 is far and away the most common suffix. More than all other digits combined

4. Using numeric prefixes

a. The number 1 is the most common prefix. The number 2 is a distant second

b. 0 and 6 are rarely used as prefixes

So what is the Bottom Line?

Often standalone machines, even those connected to the Internet, don’t do any password checking at all. Even machines administered on a network that use password checkers are often ineffective. Such password checkers generally reject only those passwords that fail some very rudimentary tests, such as passwords being entirely numeric or containing a dictionary word. These programs often fail to detect passwords that meet the simple criteria, but are still systematic and easy to guess (e.g. ‘a1b2c3d4’ or ‘asdfghjk’ (a keyboard sequence)). Further, we, as users, are very good at choosing passwords that are ‘just good enough’, because they are easier to remember. Further, although individual users can create passwords that are virtually uncrackable, in a network environment, there will be users who lack such a commitment to systems security.

If you are serious about good password security, get in the habit of using ‘pass-phrases’. For example, it is easy enough to remember a phrase like ‘…born on the 4th of July’, but creating a password from it like bot4thoJ would create a password that meets the criteria discussed above.

Combating Computer Viruses
Virulent strains of computer viruses can cause billions of dollars in damage as they quickly infect multitudes of computers via e-mail. Included in these costs is loss of critical files, extra work for IT departments, downtime from clogged servers straining to handle the mass amounts of replicated e-mail, anti-virus scans and purchase of software, and other curative measures.

Use of a virus checker regularly is the best way to combat viruses. Freeware, shareware, and commercial anti-virus programs are widely available. The program you use isn't as important as how often you use it and that you keep it updated with the most recent virus definitions. Most people get into trouble because they never bother to check their computer for viruses. 
Definition

A computer virus is a computer program that can infect other computer programs by modifying them in such a way as to include a (possibly evolved) copy of itself. A virus, by definition, can't exist by itself. It must infect an executable program. 

Note: A program does not have to perform outright damage (such as deleting or corrupting files) in order to be classified as a "virus" by this definition. 

A formal definition indicates the following about a virus: 

Virus: 
A program or piece of code that is loaded onto your computer without your knowledge and runs against your wishes. Most viruses can also replicate themselves. All computer viruses are manmade. 

Viruses are generally operating system-specific. Windows viruses don't affect Macintoshes, and vice versa. That greatly limits the destructive power of viruses. 

Different types

A simple virus that can make a copy of itself over and over again is relatively easy to produce. Even such a simple virus is dangerous because it will quickly use all available memory and bring the system to a halt. An even more dangerous type of virus is one capable of transmitting itself across networks and bypassing security systems. 

Email Viruses: 

An e-mail virus is not any different from a regular virus; it just has a different mode of transportation into your computer. To transmit a virus by email, someone has to infect a file and attach the file to the email message. To activate the virus, would have to download and decode the file attachment, then run the infected program. In that situation, the email message is just a carrier for an infected file, just like a floppy disk carrying an infected file. This was a protection against email viruses until mail systems became web-enabled. At that point it became much easier to run an attached file and turn loose a virus. So remember, there are some email programs that can be set to automatically download a file attachment, decode it, and execute the file attachment. Microsoft Outlook is a good example of such a program 

Email viruses have produced some of the most recognizable incidents in computer security: 

Exploits like the Melissa virus affected 69 percent of U.S. companies in the last year, while Trojan horse attacks more than doubled in the same time period.

The "ILOVEYOU" virus, like its predecessor Melissa (the e-mail attachment virus that propagates itself, essentially, by borrowing your address book), targets users of Microsoft Outlook and exploits a security hole in that program. The virus is activated when users open a file attachment -- a Visual Basic script masquerading as a text file named "LOVE-LETTER-FOR-YOU." Once activated, the script can send copies of itself to your entire address book and delete image and audio files from your hard drive.

The W32/SirCam@MM virus was discovered on July 17, 2001. While new viruses appear daily, most don't become a problem; SirCam did. This virus spread rapidly. Since it included user documents in its email, if you got infected, your personal and company documents got mailed around the world. This virus spread by capturing email addresses from the address book of the compromised computer, and sending itself to those addresses, after attaching to a file in the "My Documents" folder. Email infected with this virus is easily recognized by the body text: 

> Hi! How are you? 

> I send you this file in order to have your advice 

> See you later. Thanks 

Scripts:

Script viruses are destructive code that does its damage by executing a program on a client machine. These viruses are often coupled with other types of viruses such as email viruses or Trojans 

Sample Script Viruses:

· GaLaDRieL 

· Internal 

· NoWarn 

· 777 

· AVM 


· Rabbit 

· 666test 

· FreeLink 

· Monopoly 

· Netlog 

How to protect yourself from script based viruses.

The most important thing to do is to check every email you receive, file you download or are sent for a double file type (ie: .txt.vbs, or .html.jse, or whatever). If you want to make your PC more secure in regard to script viruses, you may want to remove the Windows Scripting host from your machine. (See EXERCISE 3).  It should be noted that some applications require Windows Scripting Host. They will cease to function if it is disabled or removed so if you are dealing with a UM machine, check with your administrator. Additionally, when Windows, Internet Explorer or some other products are installed or upgraded Windows Scripting Host may be reinstalled. Thus, you would then have to repeat the procedures in Exercise 3.

For further protection, you can change the file associations to ensure that script files are viewed prior to execution (See Exercise 4).

Macros:

A macro virus is a type of computer virus that is encoded as a macro embedded in a document. Many applications, such as Microsoft Word and Excel, support powerful macro languages. These applications allow you to embed a macro in a document, and have the macro execute each time the document is opened.  According to some estimates, 75% of all viruses today are macro viruses. Once a macro virus gets onto your machine, it can embed itself in all future documents you create with the application.

Macro viruses are viruses that infect "documents" - files created in different applications that do not contain not only data (texts, spreadsheets), but also macros - programs created in a special high-level language. Such viruses can spread from one document or computer to another. 

Worms: 

Some people distinguish between general viruses and worms. A worm is a special type of virus that can replicate itself and use memory, but cannot attach itself to other programs. 

For example, the Code Red worm propagates itself over TCP/IP connections and exploits a weakness in Microsoft's Internet Information Server (IIS) software, which runs on the Windows NT and 2000 operating systems. The worm directs infected PCs on the last day of the month to launch a denial-of-service (DOS) attack against the Web site of the U.S. White House.

The media made predictions about Code Red's impact and created a storm of e-mail alerts, press releases and predictions of the Internet's collapse. Predictably, the Code Red worm did not live up to this hype. The bandwidth and attention consumed by the hype greatly outweighed the impact of the Code Red worm itself. 

On 1 August 2001, security experts estimated that the Code Red worm had done relatively little damage, although the final assessment would take some time. One research firm, Computer Economics, estimated that enterprises worldwide spent $1.2 billion fixing vulnerabilities in their IT systems that Code Red could exploit.

Another worm called Nimda made news. On 18 September 2001, a new mass-mailing computer worm began infecting computers worldwide, damaging local files as well as remote network files. The w32.Nimda.A @ mm worm can spread through e-mail, file sharing and Web site downloads.

Nimda bundled several known exploits against Microsoft's Internet Information Server (IIS), Internet Explorer (IE) browser, and operating systems such as Windows 2000 and Windows XP, which have IIS and IE embedded in their code. It was much more contagious than Code Red (and thus spread much faster), but also appeared to have been less disruptive overall. 

What can we learn from these incidents?

Above all, enterprises should establish processes to make sure they promptly apply all security patches to all Internet-exposed systems and replace with more secure products those that continually have vulnerabilities exposed. As long as enterprises continue to use free software and expect to get more security than they paid for, attacks like Code Red will have a high probability of either succeeding in direct attacks or eating up attention and resources as hype makes enterprises suddenly realize their vulnerability
.

Trojans: 

A Trojan horse is a program that pretends to do something useful, but instead does something nefarious. Trojans aren't infectious. 

UM Virus Busters

Since 1987, when a virus infected ARPANET, a large network used by the Defense Department and many universities, many antiviral programs have become available. These programs periodically check your computer system for the best-known types of viruses. UM Virus Busters makes antiviral software applications that are licensed and supported by the University of Michigan available free to members of the U-M community for use on their personal or work computers for non-commercial purposes. See http://www.umich.edu/~virus-busters/ for details.
Anti-Virus Activities At U-M 


Anti-viral Software

VirusScan v. 4.5 antiviral software is for use on computers running the Windows operating system, including Windows 95, Window 98, Windows NT, and Windows 2000. 

Virex v. 6.1 antiviral software is for use on computers running the Macintosh operation system, including Mac OS 7.x-Mac OS 9.0. 

how to get it 

The VirusScan product and Virex are both available on this site free of charge, but SOLELY to members of the U-M community for use on their personal or work computers for non-commercial use. To obtain these products, access the Virus Buster’s website at http://www.itd.umich.edu/virusbusters/ and scroll down to the following link:

· Antivirus software Info - Download VirusScan (Windows) or Virex (Macintosh) directly via our Web site (U-M folks only) 

why to update it 

To be effective, antiviral software must be current -- even two-month-old software can be dangerously outdated. Check this Web page regularly to obtain any new information about antiviral software at U-M and to download the latest antivirus software updates to protect your computer. 

how to update it

For PC users (See EXERCISE 5), 

· VirusScan 4.5 for Windows 95/98, Windows NT *, and Windows 2000 clients. Released in March 2000 

i) *NT Server users cannot use VirusScan; they must instead use NetShield  

ii) VirusScan does not officially support Windows Me; however, it can be used by Windows Me users who have installed the VirusScan Service Pack immediately after installing VirusScan. If you install VirusScan on Windows Me without installing the Service Pack, your computer probably will not work. 
· VirusScan Service Pack 1: fixes a good number of problems with the original VirusScan distribution above; includes the "HotFix". Released 09 October 2000; highly recommended! 

· The most recent weekly SuperDAT file. SuperDATs: 

· Cumulatively update the virus definitions -- usually over 200 new viruses are found each week. 

· Upgrade the VirusScan engine to fix bugs and make the scanner more powerful. 

So be sure to install the SuperDAT as soon as you have installed VirusScan - before restarting your computer. 

· The most recent Emergency Recovery Utility (ERU) Diskette image, which, after downloading it to a hard drive can generate the ERU diskette. The diskette so created can then be used to boot an infected computer and then remove non-macro viruses (VirusScan on the hard drive can be used to remove macro viruses). The ERU is updated by the vendor roughly once a month. 

· Emergency virus definitions -- only a few that are not included in the current SuperDAT. Do not make the mistake of thinking that these emergency virus definitions replace the need for SuperDATs! 

Store this "EXTRA.DAT" file in the "C:\Program Files\Common Files\Network Associates\VirusScan Engine\4.0.xx" folder -- note that the folder name is really "4.0.xx"; the xx's do not represent an unknown number. 

· Relatively simple U-M-specific installation instructions, in WordPad format 

· Exhaustively Complete Vendor Documentation, in Adobe Acrobat Reader format 

and (not useful to the end user) 

· Administrator tools, including 

· Management Edition for PC server administration, 

· Policy Editor, for custom configuration 

· Installation Manager, allows an administrator to pre-configure for installation on another computer 

· NetShield (server-side protection) for Windows 4/Windows 2000 Server and for NetWare. 

· A Service Pack for NetShield's NT version 

· Documentation for the above tools 

For Macintosh users, we have: 

· Virex for Macintosh 

· Virex Administrator, for Mac server administrators 

auto vs manual

Anti-viral software can be set up to run automatically each time you boot up the machine or run an executable. You can also execute anti-viral software manually if you suspect you have had a problem or you have received a suspicious attachment or some sort of un-trusted media.

engine vs definitions

There are two parts to most pieces of anti-viral software; the engine and the definitions. The definitions change all the time. This is the part of anti-viral software that needs to be updated constantly, because the population of viruses changes rapidly, with newly developed viruses springing up along with minor modifications of existing viruses (mutations) appearing constantly. The engine, on the other hand, is static and changes only at major release points. The engine is the driving force behind a virus program that checks for virus signatures on you machine and in your software.

human anatomy analogy

The key aspect of a virus is that it can replicate itself, whether you’re talking like a virus in humans or a virus in computers. Hence it is key that you find and eradicate all viruses on your machine, because soon, it will no longer be just your problem.

I’ve been slimed!
If your software indicates that your computer has been infected with a virus, it is important to remain calm and follow the instructions provided by VirusScan. As part of the installation, you created a secure boot disk. This is used to bring up an environment in which you can run the required utilities to disinfect your machine. If you are uncomfortable with executing the instructions, call your system administrator and ask for their help in disinfecting your machine. You can also email Virus Busters with questions related to what you need to do.

Summary:

Never save executable attachments from email messages to your computer and run them (files that end with .EXE, .COM, .VBS, and .BAT are executable on Windows computers). Any unknown program that is executed on a Mac or PC can potentially be destructive. Be especially concerned if the program is shareware or transmitted via the Internet. Sometimes even trusted sources are victims of virus attacks and unwittingly send them to others-- so it is important never to run a program that has been sent via email (unless you are 100% sure of the outcome). Most email viruses are dependent upon a user to bring it to life and initiate its destructive process. 

In order to maintain good security in regard of viruses, worms, Trojans and other ‘malware’, one must use common sense and use email safely. The latter consideration includes practices such as not sending or forwarding attachments when the information can be passed as plain text in the message, and not passing on chain letters.

For more information on viruses, you can subscribe to a list maintained by VirusBusters. To do this, address a message to pcavu@umich.edu (for Windows-based machines) or to macavu@umich.edu (for Macs) with a subject line of SUBSCRIBE.

Windows Security

What Does the Term "Hardening" Mean?

The term "hardening" refers to the process of configuring software so as to minimize potential security risks. This process begins with the application of any and all available patches to fix known bugs. For operating system software and most applications, the remainder of the process consists primarily of limiting or disabling unused or risky functionality, but can include enabling security-enhancing features, removing default accounts and passwords, and removing or encrypting sensitive files.

Hardening security-specific applications like firewalls, intrusion detection systems, and antiviral tools on the other hand, generally involves turning on features and setting restrictive access rules, allowing the applications to detect and respond to as many different attacks as possible.


How Windows networking works

Microsoft Windows networking was designed to be used in small, local workgroups of 2 to 20 computers. For individual departments within a large corporation, or a couple of machines in a home network, it works great. It is very easy to share files and printers with other members of the network. Windows networking was never designed for very large networks such as the Internet. Rather than redesigning the entire networking model to make it more secure, Microsoft decided to keep Windows networking the way it was and patch it so it works on the Internet. (sort of). The major problem is that security in an environment such as the Internet was not designed in from the beginning.

Why that is bad on Internet

Because it was defined as a peer-to-peer network, by default, every Windows computer on a Windows LAN can act as a client and a server at the same time. This is OK on a local network where all the users know each other and wish to share files and printers. But, when you connect your Windows computer to the Internet, you are in effect, connecting to the worldwide network. By default, your computer is acting as a server on this network. You are now exposing your files to everyone else on the network! (Internet)

What to do to fix it

There are 3 main components to Windows networking.

· Clients

· Protocols

· Adapters

You may have one or more of each of these components. Windows sets some up automatically (such as Client for Microsoft networks). Some are added later (such as Cable/DSL interface).

Clients are services that are used by the local machine's software. For example: the Client for Microsoft networks, Client for Novell networks, File and Printer Sharing for Microsoft are clients present in the Microsoft Networking model

A protocol is an agreed-upon format for transmitting data between two devices. Protocols are the various ways that computers can talk to each other over a network - a kind of "network language" From a user’s point-of-view, generally, the only pertinent aspect of protocols is that their computer must support the right ones to communicate with other computers. However, if you are looking to harden your system, you must be concerned with some key aspects of various protocols. Examples of protocols used in Microsoft Networking are: TCP/IP, NetBEUI, IPX/SPX.

Adapters are the hardware devices that connect your computer to the network.

Example: Dial-Up Adapter, Cable/DSL interface, Network card.
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To examine the networking components installed on your system, See Exercise 6.
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You should see one or more network clients, protocols, and adapters listed. Your screen may differ from the one shown above, depending on the networking components you have installed.

The key to understanding your network configuration is to understand what “binding” means. We say that a particular network adapter is bound to TCP/IP, and that TCP/IP is bound to File and Printer sharing. If we think of these in layers, then "bindings" are the lines that connect the different layers. The picture below shows the components of a typical system. The default configuration is to bind everything on each layer with everything on the adjacent layer. This increases the exposure for to network vulnerabilities because windows nodes act as servers and are serving the WWW as well as all internal users. The important lesson is to realize that you can control these bindings. We will show you how to remove certain bindings to make your computer less vulnerable on the Internet. This will increase security tremendously (See EXERCISE #6).
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This is unsafe because the insecure Microsoft networking components — the Client for Microsoft Networks and File and Printer Sharing — are bound to the Internet's worldwide routable TCP/IP protocol, and the TCP/IP protocol is bound to all of the system adapters including those available 24 x 7. Thus, anytime this system has any contact with the Internet, the machine is available for the whole world to access.

What we want is a picture like the one below. By removing File and Printer sharing for Microsoft networks, and removing the Client for Microsoft networks, you will prevent 90% of the attacks on your machine from the Internet. These two clients are only used for sharing files between 2 Windows computers. They are not needed for normal Internet browsing and email.
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Note: This will not stop 100% of the attacks. However, it takes a much more sophisticated hacker to exploit your machine now. To stop 100% of the attacks, you will need a firewall, discussed later.

Shields Up! 

Port Scanning: -- http://grc.com

A port is an interface on a computer to which you can connect a device. Personal computers have various types of ports. In this context, a port is an endpoint to a logical connection. The port number identifies what type of port it is. For example, port 80 is used for HTTP traffic. A key to determining your computer’s security profile is to determine port usage.

To test your computer's security profile, visit the excellent online resource at Gibson Research call Shields Up! Point your browser to http://grc.com and follow the links to Shields Up! Click Probe My Ports (See EXERCISE #7).

You should see port 139 wide open. That's bad! This is the port that allows Windows computers to share files. This is also a common way that hackers can exploit your computer without you knowing about it.
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To close port 139, we need to remove the Client for Microsoft Networks (See Exercise #8). If you are dealing with a University machine, you need to consult your system administrator to see if this is appropriate. If you are working with your own machine or it is deemed appropriate for you to remove Microsoft Networking, then:

1. Start the Network applet in Control Panel. 

2. Select the Client for Microsoft Networks and click Remove, then OK. 

3. You will be prompted for the Windows 95, 98 or ME CD. 

4. Insert the CD and click OK. 

5. If you are prompted to keep existing files, click OK. 

6. You will be prompted to restart. Click Yes.

7. Restart the computer

After you restart the computer, go back to the Shields Up! site and click Probe My Ports once more. You should now note that port 139 is closed. 

Firewalls

What is a firewall?

If you've reached this point, you probably know more about Internet security and securing a Windows PC for safe Internet access than you ever thought you would. If you are using a single stand-alone PC for Internet access, the preceding pages will have equipped you to secure that machine without the need for any additional software. But if your needs are more complex, you will need some additional software to secure both ends of the Internet connection.

Firewall: A system designed to prevent unauthorized access to or from a private network. Firewalls can be implemented in both hardware and software, or a combination of both. Firewalls are frequently used to prevent unauthorized Internet users from accessing private networks connected to the Internet, especially intranets. All messages entering or leaving the intranet pass through the firewall, which examines each message and blocks those that do not meet the specified security criteria.
 A firewall is analogous to a moat around a medieval castle. In essence, the moat and drawbridge represent a control point for all traffic in and out of the castle. A single point of ingress and egress is much easier to monitor than multiple entry points and the portal can be closed if needed.

How does it work

A firewall is usually a combination of hardware and software components. Firewalls generally act either as proxy servers, by masking the address of internal machines and routing appropriate traffic or as a packet filter. A firewall functioning as a packet filer ABSOLUTELY ISOLATES your computer from the Internet using a "wall of code" that inspects each individual "packet" of data as it arrives at either side of the firewall — inbound to or outbound from your computer — to determine whether it should be allowed to pass or be blocked.
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This means that every time an unknown computer attempts to connect to your machine, you will receive an alert on your screen and, optionally, an alert will be written to a log. You can decide whether to allow or disallow the communication attempt. Note that this is a 2 way street. Not only is incoming traffic blocked, but outgoing traffic as well. This means that every program that you start that tries to access the Internet (browser, email, FTP, etc.) will be blocked and an alert will be displayed.

To avoid annoying repeated warnings, you can select certain programs for the firewall to ignore. Firewalls often will be programmed to keep track of how you answer various alerts in order to customize a security policy for your host. You also will have choices on how security is implemented. For instance, you can set a different level of security for your LAN and a different level for the Internet.

When an outgoing transmission is attempted, the user is asked to give permission to the application to complete the transfer. Likewise, when an incoming transmission is attempted, the user is alerted.

How do you get one

When you have a 24 x 7 connection to the Internet via a cable modem or DSL, your risks are greater than when you access over a slower dial-up connection. For instance, you are a perfect candidate to be a zombie in a distributed denial of service attack. Firewalls were designed to prevent unauthorized access to your computer.  A personal firewall that is available free for personal use is called Zone Alarm and is made by Zone Labs (see Exercise #9 for installation instructions). 

Zone Alarm is an example of a personal firewall and is used for illustrative purposes only. This software is not currently licensed or endorsed by UM. Further, there are other personal firewalls available such as Black Ice for the PC or Norton’s Personal Firewall for the MAC. Also, along with these software solutions, a hardware solution, in the form of a home router is available. LinkSys offers a 4-port home router that can be used to monitor traffic to and from your home system.

Zone Alarm

Care must be taken when configuring Zone Alarm. Although there are several levels of security that may be configured within the product, Zone Alarm’s basic paradigm is to block all traffic that is not specifically permitted. This is different from some other personal firewalls like Black Ice.



NOTE: When you call for help desk support or have a problem with resources and your system administrator is involved, you should always inform them if you have a continuous high-speed connection and whether or not you have a firewall running on your machine.

NOTE: If you have computer at home that runs the Novell client software, talk to your system administrator before installing a personal firewall like Zone Alarm or Black Ice. This software must be configured specifically to co-exist with Novell networking.

Backup

What is backup

A copy of files maintained on a second medium (a disk or tape) as a precaution in case the first medium fails. It is vitally important to back up you software and key files since even the most reliable computer is apt to break down eventually. We recommend that you make two, or even three, backups of all your files. You need to be cognizant, in terms of software as to how many backups you are legally allowed to make. To be especially safe, you should keep one backup in a different location from the others. 

Different types

Full Backup

Includes all files on your drive(s).

Advantages
Files are easily found when needed. Since full backups include all data on your hard drive, you do not have to search through several disks or tapes to find the file(s) you need to restore. If you should need to restore the entire system, all of the most current information can be found on the last backup tape.

Disadvantages
Full backups are redundant backups. Since most of the files on your system rarely change, each backup following the first is mostly a copy of what has already been backed up. Full backups take longer to perform and can be very time consuming.


Incremental Backup *

Includes files that were created or changed since the last backup.

Advantages
Incremental backups provide better use of media. Only files that were created or changed since the last backup are included, so there is much less data storage space required. Less time is also required, since it only backs up the files that have been modified since the last backup.

Disadvantages
Multiple disks or tapes are needed for restore. The files can be spread over all the media in use since the last full backup. You may have to search several volumes to find the file you wish to restore.


Differential Backup * 
Includes all files that were created or modified since last Full backup. 

Advantages
Differential backups take less Time. This method requires much less time than a Full backup. Hence, it provides more efficient restores. You will have a maximum of two media sets to perform a full restore, the last Full backup and the last Differential backup tape.

Disadvantages 
As time goes on a Longer and longer time needed for a differential backup. The amount of data backed up each day following the Full backup gets larger and larger each day. For example, if the Full backup was done on Friday then Wednesday’s differential backup would have the data that was backed up on the Monday tape and on Tuesday’s tape plus whatever was changed or created on Wednesday. Differential backups are redundant backups. Each day’s backup would store much of the same information plus the latest information added or created since the last Full Backup.

Why do you do it?

The key reason to do backups is that most business are out of business if they lose their ‘mission-critical’ data. Increasingly, such data resides on the organization’s personal computers. Without backups, a physical disaster, a hardware breakdown or an inadvertent software deletion can wreak havoc on an organization. With backups, the file is restored and only that activity that occurred since the time of the last backup needs to be recreated. 

How do you do it.

You do backups through a coordinated strategy geared at doing the most efficient combination of backups possible in terms of ease of recovery and usage of media.

Creating a Backup in Windows

Follow the following steps to create a backup (See Exercise #10):

1. Start>Programs>Accessories>System Tools>Backup

2. The Backup Wizard starts. 

Note: We will not be using the wizard in this class. After you are familiar with the backup and restore options, you can use the wizard to easily create backup and restore jobs.

3. Click Close to close the Backup Wizard.
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The Backup window gives you quick access to all the backup features. You can create a backup in just three steps using the Backup window: The Backup window lets you 

1. select drives, folders, and files to back up. 

2. Select options 

3. schedule a backup. 

Before running a back up you must save your Backup Job

.

The Backup window includes four main sections:

1. Backup Job -- Displays the Backup Job box, and the Start button. Use the Backup Job box to select a previously saved Backup Job.

2. What to back up -- Displays the Backup selection panes and two backup type options: All selected files and New and changed files.

3. Where to back up -- Displays the Where to back up box.

4. How to back up -- Displays option settings and the Options button.

Choose the files that you want to backup. If you choose to backup only a few files, simply check the box next to the file. Checking a box next to a folder will select all files and folders within the selected folder. Checking a drive letter selects all the folders and files on that drive.
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A blue check mark indicates the entire folder is selected for backup while a gray check mark next to a drive or folder indicates that some, but not all, files on that drive or folder are selected for backup. 

Note: Network drives may be selected for backup, just like any other drive.

Next, select whether to backup every selected file, or only backup a file if it is new or has changed since the last backup.

If you select New and changed files, Windows backup will use the default settings for the backup type. To change the specified backup type for new and changed files:
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1. In the Backup window, click Options. 

2. Click the Type tab. 

3. Click New and changed files only. 

4. Click Differential backup type or Incremental backup type. 

Choosing Where to Back Up
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Use the Where to back up box on the Backup window to designate where your files are backed up. 

1. Click a device, or click FILE and back up your files to your hard drive, a network drive, or a floppy disk.

2. Type a folder and filename in the text box. If you type a filename without an extension, this program adds a .qic extension to your file. 

-Or-

Click Browse (the button with the open folder icon), click a folder and a file within that folder, then click Open. 

Note: The File option does not require that your files be written to a medium that is formatted for backup use only. You may want to use the File option if you plan on using a medium for purposes other than backup. However, if you use a medium that is formatted for backup use only, you may write only backup files to that device. 

3. Click Start to start the backup. After the backup is complete, you can view or print a report with details of the backup job.

Creating a Weekly Backup Cycle

Be prepared for your backup. Label your media. If your backup requires more than one medium, label and number all the media in advance so you can recognize them easily. 

Start your cycle on Friday. Insert your first medium in the backup device and perform an 

“All Selected Files” backup. 

1. On Monday reinsert the medium you used for the All Selected Files backup and perform an Incremental backup. The Incremental backup is automatically appended to the All Selected Files backup. 

2. Tuesday through Thursday, perform Incremental backups. Each subsequent Incremental backup is appended to the previous backup. If you need more than one medium, you will be prompted to change media. After your Thursday backup, you will have a complete rotation set. 

3. On Friday repeat the cycle with a second set of media. 

Backup Performance Considerations

Various factors affect backup performance.

1) Compress data to save time - Compression can be used to decrease the total backup time and the required storage space. 

a) To turn this option on, click OPTIONS in the Backup window, and then click COMPRESS DATA to save time.

2) If your data has already been compressed

a) Click NEVER COMPRESS THE DATA. Compressing data that has already been compressed causes the data to occupy more media space.

3) Compare original and backup files to verify data was successfully backed up -  This process checks the data by reading it back from the backup media and comparing it to data in the buffer (memory). Running a backup with this check box selected can cause your backup to take twice the amount of time to complete. To optimize speed, clear the check box Compare original and backup files to verify data was successfully backed up.

Running a Restore 

See Exercise #11 for details.
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2) Click a device to restore from in Restore from. 

3) Select the check boxes associated with the drives, folders, and files you want to restore. 

4) Choose a restore destination in 

5) Click OPTIONS to set your options

6) Click one of the following options, the click OK

a) Do not replace the file on my computer (recommended)

b) Replace the file on my computer on my computer only if the file is older

c) Always replace the file on my computer

Where to restore

1) Click OPTIONS to set your options. 

2) Click one of the following options, and then click OK. 

a) Do not replace the file on my computer (recommended)

b) Replace the file on my computer only if the file is older

c) Always replace the file on my computer

3) Select a location for your restore

Connected Backups at UM

Data stored on department servers is secure and protected against corruption. However, data stored on individual workstations, whether desktop or laptop is vulnerable to hard drive crashes, viruses, and theft of the device. Wise users understand that the best protection against loss of vulnerable data is the regular backup of that data to a secure space.

If your data is important, but you are reluctant to set up and administer your own backups, you can turn to ITCS to do it for you for a fee. ITCS LAN NOS Services provides a secure, regularly scheduled backup service for Windows 95, 98, NT and 2000 desktop and laptop machines. This service is not available on non-Windows workstations. This service provides an efficient and reliable means to protect the data stored on personal workstations and a way to recover the data in the event of a disaster. Backups can be made over any IP network connection. The CNB server will keep up to 20 versions of each file backed up from the hard drive. See http://www.umich.edu/~lannos/cnb.
Learning More after Class

Web Sites

Check the following websites for more detailed discussion of some of the terms and techniques discussed in this class:

1. Web 101 Resources Page: http://www.awl.com/hehnertweb101/ 

2. Webopedia Computer Dictionary: http://webopedia.internet.com/TERM/v/virus.html 
3. Source for Microsoft Updates: http://www.microsoft.com/ 98/downloads/corporate.asp
4. Tips for the Internet and Windows: http://members.tripod.com/philomanshomepage/tip5.htm
5. U-M Virus Busters  http://www.umich.edu/~virus-busters/
Other IT Education Services Classes

If you want to learn more about computer security vulnerabilities, consider taking the companion course "Technology and Security - How Vulnerable Are You?"
Online Tutorials 

Faculty, staff, and students at the University of Michigan are invited to learn "Online" via our NETg training library. The library of over 200 courses is available free of charge to all UM faculty, staff, and students. Unfortunately, the library is not available to learners without a UM uniqname and password. The following courses may be of interest

· Web Sites Implementing Security - Part 1 

· Web Sites Implementing Security - Part 2 

· MS Win 98 Support Troubleshoot

References
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Exercises

Exercise 1: Setting Windows Passwords:

Screen Saver:

1) Click on SETTINGS

2) Click on CONTROL PANEL

3) Click on DISPLAY

4) Choose the SCREEN SAVER tab

5) Select your favorite screen saver

6) Check the box for PASSWORD PROTECTION

7) Select a duration – you may want to start with 10 minutes

8) Preview the selections

9) Click OK

Networking:

1) Click Start, Settings, Control Panel, Network

2) Select Windows Logon from the Primary Network Logon field

3) To change the password for an account:

a) Log on using the current password 

b) Navigate to Start, Settings, Control Panel, and Passwords.

4) You’ll have to restart to implement the changes.

Exercise 2: Finding the Password File:


Note: Not for Windows NT/2000

1) Click on START

2) Select SEARCH

3) Select FILES or Folders

4) Type in *.PWL

5) Select FIND NOW

6) Click on files found

Exercise 3: The Windows Scripting Host 

 Windows 98

WSH is installed if you choose a standard installation of the operating system, or if you install Internet Explorer 5, or if you download WSH from Microsoft:

1. From the Windows taskbar, select Start|Settings|Control Panel. 

2. In the 'Control Panel' screen, double-click the 'Add/Remove programs' icon. 

3. In the 'Add/Remove Programs' window, open the 'Windows Setup' tabbed page. Select 'Accessories' and double-click. 

4. In the 'Accessories' list, find 'Windows Scripting Host'. 

5. Click on the check-box by 'Windows Scripting Host' to deselect it. 

6. Click OK to return to 'Add/Remove Programs' window. Then click on 'OK'. 

Windows 95

WSH is installed if you install Internet Explorer 5, or if you download WSH from Microsoft:

1. On the 'Desktop', or in 'Windows Explorer', right-click on 'My Computer'. 

2. Select 'Open' from the menu. 

3. In the 'My Computer' window, open the 'View' menu and select 'Options...'. 

4. Open the 'File Types' tabbed page. 

5. Look for 'VBScript Script File' in the list of file types (if you can't find it, your machine is safe and you don't need to do anything else). 

6. Click on the 'Remove' button. 

7. If you see a dialog asking you to confirm removal, click 'Yes'. 

Windows NT 4.0

WSH is installed if you install Internet Explorer 5, or if you download WSH from Microsoft:

1. Log on as an administrator. 

2. On the 'Desktop', or in 'Windows Explorer', right-click on 'My Computer'. 

3. Select 'Open' from the menu. 

4. In the 'My Computer' window, open the 'View' menu and select 'Options'. 

5. Open the 'File Types' tabbed page. 

6. Look for 'VBScript Script File' in the list of file types (if you can't find it, your machine is safe and you don't need to do anything else). 

7. Click on the 'Remove' button. 

8. If you see a dialog asking you to confirm removal, click 'Yes'. 




Windows 2000 and Windows Me

WSH is installed by default:

1. Log on as an Administrator. 

2. On the 'Desktop', or in 'Windows Explorer', right-click on 'My Computer'. 

3. Select 'Open' from the menu. 

4. In the 'My Computer' window, open the 'Tools' menu and select 'Folder Options'. 

5. Open the 'File Types' tabbed page. 

6. Look for 'VBScript Script File' in the list of file types (if you can't find it, your machine is safe and you don't need to do anything else). 

7. Click on the 'Delete' button.

8. If you see a dialog asking you to confirm removal, click 'Yes'.

Exercise 4: Protecting against script viruses

The steps to change the file associations vary slightly depending on which version of Windows you’re using.

1) Double-click My Computer on the Desktop 

2) Go to the View menu

i) Windows 95: On the View menu, click Options 

ii) Windows 98/NT: On the View menu, click Folder Options 

iii) Windows 2000: On the Tools menu, click Folder Options 

3) Click the File Types tab 

i) Scroll through the list of file types.

ii) Select a type: JS JScript file 

4) Windows 95/98/NT: Click the Edit button 

a) Windows 2000: Click the Advanced button 

5) In the Actions list, select Edit 

6) Click the Set Default button 

7) Click OK 

8) Repeat steps 4 – 8 for each of the other 4 file types 

1. JSE JScript Encoded file 

2. VBS VBScript file 

3. VBE VBScript Encoded file 

4. WSF Windows Script file 

9) Click OK when done 

This will only help against Script viruses - you should still learn how to update your virus definition files, and always be careful about opening attachments. 

Exercise 5: Downloading Anti-Virus Software

1) Open up Netscape or Internet Explorer

2) On the Address Bar put in http://www.itd.umich.edu/virusbusters/ 
3) Scroll down to Download VirusScan (Windows) or Virex (Macintosh) and click on it

4) Scroll down to Download the current version of VirusScan and instructions for installing it and click on it

5) Scroll down to the list box containing VirusScan v.4.5 for Windows-95, Windows-98, Windows NT 4.0 Client. 
6) Click on GO!

7) If warned about using a secured connection, click OK

8) Type in your UNIQNAME and password

9) Save the program to disk in MY DOCUMENTS

10) Wait for indication that the download is complete

11) Browse to the MY DOCUMENTS library 

12) Double click on VSCI45l.EXE

13) When the installer screen comes up, click OK

14) Click SETUP on the Self-Extractor screen

15) Follow the prompts

16) Select INSTALL

17) Select SCAN MEMORY FOR VIRUSES BEFORE CONFIGURING

18) Select CONFIGURE

19) Choose the options to 

a) Scan boot at startup

b) Create Emergency Disk

c) Run default scan for viruses after installation

20) Choose Format using installed OS 

21) Choose

a) Format

b) Full

c) Copy system files (IMPORTANT)

22) After the diskette has been formatted, label it and put it aside

23) Choose to RUN AUTOUPDATE (it may not be available)

24) Start the virus scan

25) Upon completion, return to STEP 5 above 

a) Select Service Pack 1

b) Download the file vsc45sp1.exe to disk

c) Browse to it and double click on it

d) Follow the prompts

26) Upon completion, return to STEP 5 above 

a) Select the latest SuperDat file

b) Download the file (e.g. sdat4149.exe) to disk

c) Browse to it and double click on it

d) Follow the prompts

27) Reboot the computer

Exercise 6: Examine Networking Components

1) Click on START

2) SETTTINGS

3) CONTROL PANEL

4) Open the network applet by clicking on the NETWORK icon.

5) Select CLIENT for Microsoft Networks

6) Click on FILE and PRINT Sharing

7) If the boxes are clicked, unclick them

Exercise 7: Probing for Open Ports

1) Open up Internet Explorer

2) Point your browser to HTTP://WWW.GRC.COM
3) Scroll down to Shields Up! and click on CLICK HERE!

4) Click -- PROBE MY PORTS!

5) Note if Port 139 is open

Exercise 8: Close Port 139

1) Click on START

2) SETTTINGS

3) CONTROL PANEL

4) Open the network applet by clicking on the NETWORK icon.

5) Select CLIENT for Microsoft Networks

6) Click REMOVE, then OK

7) You will be prompted for the Windows-98 CD

8) Insert CD and click OK

9) If you are prompted to keep existing files, click OK

10) At the RESTART prompt, click OK

11) Restart the computer.

12) Repeat EXERCISE #7

Exercise 9: Downloading a Personal Firewall

1) Open up Internet Explorer

2) Point your browser to HTTP://WWW.ZONEALARM.COM
3) Scroll down to ZONE ALARM Free Download

4) Review the features

5) Click on a location and initiate your download

6) Choose to SAVE TO DISK

7) Save the file ZONALM26.EXE to MY DOCUMENTS

8) Use Windows Explore to browse to ZONALM26.EXE

9) Follow the prompts

Exercise 10: Creating a Backup In Windows

1) Click START

2) Select PROGRAMS

3) Select ACCESSORIES

4) Select SYSTEMS TOOLS

5) Select BACKUP

6) Click CLOSE to do backups without the Backup Wizard

7) Select CREATE A NEW BACKUP JOB

8) From the Backup window, choose:

a) What to Back Up

i) Choose the files you wish to backup

(1) Checking a box next to a folder will select all files and folders within the selected folder

ii) Choose ALL SELECTED files

b) Where to back up

i) Click a device or click FILE and back up your files to your hard drive, a network drive or a floppy disk.

ii) Type a folder and filename in the text box

c) Click START to start the backup

Exercise 11: Running A Restore

1) Click START

2) Select PROGRAMS

3) Select ACCESSORIES

4) Select SYSTEMS TOOLS

5) Select RESTORE

6) Click a device to RESTORE FROM

7) Select the check boxes associated with drives, folders and files you want to restore

8) Choose a RESTORE DESTINATION

9) Click OPTIONS

a) Select the appropriate option

i) Do not replace the file on my computer is recommended as a default option
ii) Select a location for your restore
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